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Key Symbols 
Money Saving Tips: Throughout this book, I’ll 

point out some optional money saving tips.  
 

Idea: I’ll indicate handy tips throughout the book 
in this way. 
 
Text to modify in a file 
 
Text to delete in a file 
 

 A detailed example
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Introduction 
 
If you have a product (or service) that you want to 
market online, then this book will show you how.  
 
Not a computer whiz? Creating a website isn't much 
harder than creating a document in your word 
processor. There are clear step-by-step instructions 
for doing everything online. 
 
Don’t have a lot of time? Spend more time selling 
your products (services) and less time setting up 
your business using the detailed steps. 
  
Limited budget? For less than $40 a year, you can 
get you a very nice website. For less than $6 a year, 
you can get you a minimal website with your own 
domain name. This book shows how to create a nice 
website for free. 
 
Have a website? Besides creating a website, there 
are also instructions for: analyzing your web traffic, 
adding a shopping cart, and creating printed 
marketing materials. 
 
Why do professionals charge $1000s? Anyone can 
create an online business. Making the website look 
"sharp" is a job for the pros. If you don't have 
thousands of dollars to spend, create something 
functional now and improve it later. 
 
Just starting your first business? After working 
through this book, you’ll have both online (website, 
email, website analysis, and a shopping cart) and 
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supporting printed marketing materials (business 
cards and flyers). You'll learn what you need to 
market yourself effectively. 
 
The book is divided into day-projects. How long you 
take to do a project is based on the combination of 
how motivated and skilled you are. Unless you start 
businesses regularly, you’ll be learning some new 
skills during this month. Follow step-by-step as 
someone implements each day’s goals in the 
Examples section. 
 
Remember: It’s your business, and you should 
definitely do things in ways that reflect who you are. 
However, there’s no reason that you can’t learn from 
others’ successes and failures. 
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 Physical Business Issues 
 
Unless you already have a physical (“brick-and-
mortar”) business, there are some business startup 
issues to solve: 
 

 Strategic Plan – This document answers the 
key issue for your business: “What 
customer problem am I solving?” You 
highlight how your product (service) solves 
their problem. Without a clear plan, you’ll 
be wasting a lot of time and money. Since 
people primarily care about health, wealth, 
or relationship. Your business message 
should address (at least) one of these areas. 

 
 Business Name – Your name should reflect 

the problem you’re solving. 
 

 Address – Are you operating out of your 
house, a Post Office Box, or an office? You’ll 
need a physical address to make people 
comfortable with your business. You need 
an address to receive mail (for people that 
want to send you money). 

 
 Legal – How is your business organized? 

Most people start their businesses as a sole 
proprietorship, but you might have a 
partnership. 

 
 Business Checking Account – How is money 

going to get to you? 
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Nolo Press (nolo.com) has a wonderful collection of 
legal self-help books as well as articles to help you make 
expensive mistakes. 
 

 See example on page 45. 

http://nolo.com/
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 Select Online Name 
 
Unless the name of your business is part of your 
name (“Jane Smith and Associates”), you’ll probably 
(rules vary from state-to-state) need a DBA (“Doing 
Business As”) form. File the form with your County 
Recorder/Clerk’s office. 
 
For your online business, consider filing a DBA. A 
DBA is used for obtaining a business checking 
account and also for preventing others from using 
your business name. 
 
The rules for naming a brick-and-mortar or online 
businesses are basically the same: 
 

 Highlight the benefit of your business (what 
problem are you solving?) 

 Avoid superlatives (“Best Drums”) 
 Don’t limit the name based on geography 

(unless desirable) (“Sioux City Skates”) 
 It’s a unique name. 
 It’s easy to spell. 
 Test it out on friends. 
 Don’t sweat the name too much – it’s not the 

name that attracts people, it’s the offering. 
 
Your online name is called a domain name. To see if 
your selected name is already used, use a free 
service such as www.whois.net. If you are starting a 
non-profit, you’ll want your domain name to end in 
.org, otherwise your domain should end in .com. 
Avoid dashes (-) and underscores (_) in domain 
names; people have a hard time correctly 

http://www.whois.net/
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remembering these characters. A thesaurus can be 
handy to help you brainstorm name ideas. 
 

Secondary Domain Names: Purchasing 
secondary domain names (aliases) is done often to 
protect the website name from competition and to 
make it easier to find. Secondary names can 
automatically forward people to a primary website 
(as if they typed in the primary domain name). 
 
 
 

 See example starting on page 46. 
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 Get Your Domain Name and Host 
 
There are hundreds of companies that can register 
your domain name for you. They basically all do the 
exact same thing but charge wildly different 
amounts. 
 

Privacy: When you register your domain name, 
your name, address, phone number, and email 
address are listed in a public database for all to see. 
If you don’t want this information to be public, 
consider registering your domain privately. It makes 
it harder for people to spam you. 
   
It can take a day (or two) to get the domain name 
published (so your domain name is recognized by 
web browsers world-wide). 
 
 

Web Pages  
 
 Web Host/Server 

 
 Web Browsers 

 
 
A web host (also called a web server) stores your 
web pages and sends your pages to people (using a 
web browser) who want to look at your website. 
There are hundreds of web hosting companies that 
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basically do the exact same thing (but differ in price, 
extras, and customer support). 
 

Do It Yourself Web Hosting: If you have: a spare 
computer (that can remain on all the time), a fast 
Internet connection, a good backup system, and are 
computer-savvy, you can host the website yourself. 
 

Free Web Hosting: If you absolutely have no 
money to start your business you can create a free 
website with free email (see Appendix 1: Free Gmail 

Account and use -  Google Page Creator). It 
looks less than professional (because you don’t have 
your own domain name), but if your choice is no 
business or a less than professional one, start the 
business, and later upgrade.  
 

Inexpensive Domain Names & Web Hosting: 
www.1and1.com currently charges (for its Beginner 
Plan) $2.99/month for: a domain name, website 
hosting, email. Besides being inexpensive, they are 
reliable and provide a few nice extras (including free 
private domain registration). If you refer others to 
1and1.com, you earn money as an affiliate. Note: 
Examples in this book will be using 1and1.com, but 
you can use a website hosting company of your 
choosing. 
 

Instant Domain Plan: www.1and1.com has a 
great deal (for its Instant Domain Plan) if you just 
need: a domain name, minimal website hosting, and 
email. If you can live with a 5 page website built 

http://www.1and1.com/
http://www.1and1.com/
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from their templates, you can purchase it for 
$5.99/year (which includes private domain 
registration). You can later upgrade from this plan 
to a 1&1 Beginner Plan. Be forewarned: the template 
solution with 1&1 prevents you from using website 
analytics and shopping carts. 
 

 Hosting Type: You generally have a choice 
between Linux and Microsoft hosting. Choose 
“Linux”; it’s considered to be more “robust”. 

 
 
 

 See example starting on page 49. 
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 Find Graphics 
 
Websites are visual. The right image reinforces your 
website text. Find images that you can ideally use 
not only on your website, but also in your 
brochures, business cards, etc. Collect a lot of 
images that relate to the benefit of your business.  
 

 Inexpensive Graphics: Search online for “stock 
photography” or “clip art library” (e.g., 
images.google.com and pdphoto.org). You may want 
to use (digital) photographs you’ve taken or 
(scanned) images you’ve drawn. There are also many 
free ways to crop and/or enhance your digital 
images (e.g., www.snipshot.com). Website templates 
may provide a number of nice graphics and color 
palettes. 
 

 Image Ownership: Many online images cannot 
be used for business purposes without a license (or 
paying a royalty). In some cases, this is a relatively 
small amount, but the price for high-quality images 
can be quite expensive. If an image is “public 
domain”, then you’re literally free to use the image 
as you wish. 
 

 Graphic Consistency: One trick that separates 
amateurs from professionals is that the pros know 
to use images that look like they belong together. 
Amateurs use clip art from various sources (and it 
shows). If you find an image that you like, try to find 
other images by the same artist/photographer. 
 

http://images.google.com/
http://pdphoto.org/
http://www.snipshot.com/
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Color Schemes: Another trick that the 
professionals know is that color affects mood. Too 
many colors (just like too many fonts) distract the 
reader. You want to find colors that “belong” in the 
same palette. I often use the same color palettes of 
websites I like. 
 

 See example on page 56.
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 Email 
 
You don’t want your business email address to be 
janedoe@yahoo.com (the problem is the “Yahoo”). 
You do want your email address to reinforce your 
domain name (janedoe@mybiz.com). 
 
Emails to one address can be forwarded to another 
address, just like postal mail can be forwarded when 
you move.  
 

Creating Your Email Account 
 
Create your main janedoe@mybiz.com mailbox. 
Remember to allow for time for your web host to 
implement each email account.  
 
While you can create additional email addresses 
(e.g., help@mybiz.com or info@mybiz.com), unless 
you explicitly forward these to a single email 
address, you’ll have to check each mailbox 
separately.  
 

 Catchall emails: Some hosts can create catchall 
email accounts (*@mybiz.com). Catchalls can be 
used to catch typos as well as providing the same 
functionality of multiple mailboxes. 
 
 
 
 

mailto:janedoe@yahoo.com
mailto:janedoe@mybiz.com
mailto:janedoe@mybiz.com
mailto:help@mybiz.com
mailto:info@mybiz.com
mailto:*@mybiz.com
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Using Web-Based Email Program 
 
Your host provides a way to send and receive emails 
using a web-based program (you’ll have to login to 
get your emails). While you might not want to use it 
regularly (it may be too cumbersome), learning how 
use their program means you can access you email 
when you’re not at your computer. 
 
After logging in to you (web-based) email program, 
try sending and receiving emails to/from another 
email address. Does your message arrive correctly? 
How long does it take to arrive?  
 

Using Your Own Mail Software 
 
If you already use an email program (such as 
Microsoft Entourage™ or Outlook™), you can have 
these programs for your email using either: POP 
(Post Office Protocol) or IMAP (Internet Message 
Access Protocol). IMAP has the slight advantage of 
allowing you to access new messages quicker. 
 
You’ll need the following information from your 
newly created domain’s email account: 

 Account ID: your mailbox name 
 IMAP server: also known as the 

incoming server 
 Password: of your mailbox 
 SMTP server: also known as the 

outgoing server 
 

 See example starting on page 57. 
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 Business Cards 
 
Do you really need business cards if you’re creating 
an online business? Yes. Cards are helpful to use as 
an introduction to others and are easy to carry. 
 

Capitalization: Since the Internet ignores 
domain name capitalization, be sure to capitalize 
your domain name (and email address) so it reads 
well (to a human) on your business card and in 
correspondence (e.g., mybusiness -> MyBusiness). 
 
What information goes on a business card? 

 Your name 
 (Optional: Your title) 
 Business name 
 Contact information (address, phone) 

 Email address (  Email) 

 Website (  Get Your Domain Name) 
(you probably don’t need the www. 
prefix for your website) (MyBiz.com). 

 A graphic or logo (  Find Graphics) 
 What problem do you solve? 

 
Image: A sharp image makes your company seem 

look bigger or more successful. Graphic artists know 
lots about appearance: colors, fonts, proportion, etc. 
Once your business is profitable, invest in 
professionally designed business cards. Even if you 
don’t have the money to pay for the cards, consider 
interviewing graphic designers. They may provide 
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some free suggestions, knowing that once you have 
some money you may hire them. 
 

Global Designers: Instead of using a local 
person, you can try finding someone online (e.g., 
www.designoutpost.com or www.elance.com). 
 

Professional Business Cards: VistaPrint.com will 
print 250 cards for “free” (they charge five dollars for 
normal shipping and handling). The upside: the 
cards are four-color and are printed professionally. 
The downside: it normally takes 21 days to get the 
cards, there’s a small ad on the back of your card, 
the cards are cut slightly smaller than normal 
cards, and the text placement is limited. If you’re 
not in a hurry, I’d suggest waiting until after your 
website is done and you’ve had more time to think 
about your business (I’ve had to re-do my business 
cards three times). Bonus: you can earn affiliate fees 
when your referrals order business cards. 
 

Do-It-Yourself: Use your computer’s printer and 
word processing program to make business cards (if 
your computer printer can print out card stock), 
Your local printer can print out one-sided 4 color 
images onto card stock. 10 cards fit on an 8.5 x 11” 
sheet. Printers will often let you print out a proof 
sheet for free. This is important since the colors may 
vary from your computer to their printer. 
 

 See example on page 68. 

http://www.designoutpost.com/
http://www.elance.com/
http://www.vistaprint.com/
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 Website Look 
 
Websites have similar layouts since people have 
been trained to expect certain things. If something is 
not immediately clear on your website, most people 
won’t bother to try (and they’ll leave your site). 
 

Website Layout Guidelines 
 A banner across the top of the page with the 

name of your business and your business 
logo/graphic. 

 A title that reflects the page contents. 
 Familiar web page names: About, Home, 

Contact, etc. 
 A menu, either horizontally below the 

banner or vertically down the left side. 
 Important text is “above the fold” (no 

scrolling required to see it). 
 Every web page should present one idea. Too 

much clutter overwhelms. 
 Contact information is on every page of your 

website (as a minimum, at the bottom of the 
web page) 

 One or two fonts (and sizes) used at most on 
a single page. 

 A color palette with complementary colors. 
 Graphics optimized for slower Internet 

connections. 
 Avoid animation, frames, music, etc. until 

you know the implications. 
 (Optional) Signup form on the right side of 

the page, immediately below the banner. 
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Look at other websites you like. What do you like? 
What bothers you? What colors are hard to read? 
What fonts? What font sizes? Consider how you 
want to present your business to the world. 
 

 Image: A sharp image makes your company 
seem look bigger or more successful”. Website 
designers know lots about appearance: layout, 
colors, fonts, proportion, etc. When you do your own 
website, it’s unlikely you’ll have the same “wow” 
feeling. Once your business is profitable consider 
getting your website rewritten by a pro. 
 

 Global Designers: Instead of using a local 
person, you can try finding someone online (e.g., 
www.designoutpost.com or www.elance.com). 

http://www.designoutpost.com/
http://www.elance.com/
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 Paper Website 
 
Now that you have a general idea for the look of 
your website, manually create your website. 
Working offline to do design is very efficient. 
 

 Grab a stack of blank 8.5 x 11” paper and a 
couple of colored pens. 

 Think of each sheet as page on your website. 
 Sketch out what each page on your site 

does.  
 Title the pages. 
 Figure how to navigate between pages. 
 Ensure there’s a way to get from each page 

back to the home page. 
 

Website Suggestions 
 

 Each page should convey a single message. 
Don’t make a “kitchen sink” page. Studies 
show that people, when confronted with lots 
of choices, don’t choose anything! 

 If you’re offering a service, consider writing 
your common advice (so they can begin to 
trust you). What are the top 10 mistakes 
people make? Make the advice concrete, 
useful, personal, and non-obvious. You want 
your information to be memorable. 

 If you’re offering a product, how will you 
convey the quality of your product? 
Pictures? Guarantees? 

 Testimonials are great. 
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 A list of past clients 
 If you’re planning on selling directly from 

your website, use a shopping cart 

( Shopping Carts ) - a way for people to 
choose from a list of your offerings and pay 
for the order online.  

 
Books that discuss website design: 
 

 Robin Williams Web Design Workshop (by 
Robin Williams, John Tollett, and Dave 
Rohr) 

 The Design of Sites (by Douglas K. Van 
Duyne, James A. Landay, and Jason I. 
Hong) 

 
Websites that discuss website design: 
 

 webstyleguide.com 
 websitetips.com 
 www.WebsitesThatSuck.com 

http://webstyleguide.com/index.html
http://webstyleguide.com/index.html
http://websitetips.com/
http://www.websitesthatsuck.com/
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 Demo Your Paper Website 
 
“Focus test” your website with people. 
 
Describe to others what your paper website is. Show 
them your home page and then when they click on 
something, hand them the appropriate website page. 
 
Record all comments (even if you disagree with 
them) – ideally with a tape recorder so you can focus 
on the presentation instead of stopping/starting to 
write down others’ comments. 
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 Rework Your Paper Website 
 
Using successive iteration, keep making small 
changes to improve your website. You’ll eventually 
be doing this online, but until you are fluent with 
website manipulation, you’ll better be served by 
doing it on paper. 
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 Start Online Website 
 
A website is a collection of web pages. A web page is 
a description of what to display where in a web 
browser. The description is generally written using 
the HTML computer language. While you can write 
the description directly using HTML, most people 
instead choose to use a word processor-like web-
authoring program (it creates the HTML based on 
what you manipulate on screen). 
 
There is no one right way to create your own 
website. You’ll be facing the traditional tradeoffs: 
Time vs. Cost vs. Quality. You can minimize time + 
cost, but you’ll be sacrificing quality (etc.). Whatever 
option you choose (you can later change your mind) 
remember that a website will need regular 
maintenance (to keep the content fresh) and that 
you’ll need to factor this on-going expense into your 
budget/calendar. 
 

e 

 

Tim
Quality 
Cost 
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You’ll probably create your first website from a 
template, a fill-in-the-blanks solution. You’ll pick 
the page style, customize the colors, and fill in your 
content. Using a template, you can literally create a 
working website from scratch in a couple of hours 
with minimal computer skill. How well it looks is 
based on how well you can fit your needs into what 
the template provides. 
 
 
 
How Create? Time Cost Quality 
Blog Software Medium Lowest Variable 
Part of Online 
Store 

Medium Variable Variable 

Web Authoring 
Software 

Slowest Variable Highest 
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Blog Software 
 
A blog (“WebLog”) is more than an online diary; the 
diary software can also easily edit web pages. This 
has become a very popular improvement from using 
basic web authoring software. There is a large 
library of blog templates. With a blog, you don’t have 
to have special software on your computer (it’s 
installed on your website). This means that you can 
update your website from any computer (and also 
allow others to update your site as well). 
 
Setting up blog software requires you to be fairly 
computer savvy. While there are a number of sites 
online that provide support, there’s still a learning 
curve to figure out the setup process. Once it’s 
installed, maintaining it is straightforward (and 
doesn’t require you to be computer-savvy). 
 

 Free Blog Software: wordpress.org/download 
has a powerful blog package to use on your domain. 
There are lots of free templates for WordPress as 
well (e.g.,  wordpress.org/extend/themes). 
 

http://wordpress.org/download/
http://wordpress.org/extend/themes/
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Part of an Online Store 
 
If you have a product to sell, you can create an 
online store that’s part of an existing online website. 
This has the advantage of leveraging another 
company’s customer base to market your products 
to. You can create an online store as a substitute for 
your own website or in conjunction with it. 
Examples include (and are well-documented by each 
of the vendors offering this service): 
 

 eBay Store 
pages.ebay.com/storefronts/seller-
landing.html 

 
 CafePress 

cafepress.com/cp/info/sell/makemoney 
 

 Amazon 
amazon.com/gp/help/customer/display.ht
ml?nodeId=1161232 

http://pages.ebay.com/storefronts/seller-landing.html
http://pages.ebay.com/storefronts/seller-landing.html
http://www.cafepress.com/cp/info/sell/makemoney/
http://www.amazon.com/gp/help/customer/display.html/104-6449947-6315915?ie=UTF8&nodeId=1161232)
http://www.amazon.com/gp/help/customer/display.html/104-6449947-6315915?ie=UTF8&nodeId=1161232)
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Web Authoring Software 
 
There’s a wide range of web authoring software – 
everything from beginner to professional solutions, 
simple programs that run in your browser to 
standalone programs that run on your computer, 
and simple to complex interfaces to finely tune your 
website. You’ll learn such things as HTML, CSS, and 
how to optimize your page performance. There are 
lots of classes that will teach you how to write your 
own site from scratch. There are also a number of 
books with great step-by-step directions. However, it 
can feel quite maddening if you want to get the 
website up quickly.  
 
Commercial software programs provide a nice 
interface (“WYSIWYG”) and generate web pages 
containing HTML.  You can, if you’re truly driven, 
create the HTML files manually (in a text editor) – 
but that’s for the truly fanatical website designers. 
Commercial software also has the expectation that 
you’ll be able to get support when you have 
difficulties. 
 

 www.consumersearch.com/www/software/web-
design-software/review.html offers a great 
comparison of web design software (both 
commercial and free).  
 

HTML: You’ll eventually need a way to 
incorporate additional features to your website (e.g., 

 Website Metrics and  Shopping Carts ). 
Fortunately, this is simply a matter of copying in 

http://www.consumersearch.com/www/software/web-design-software/review.html
http://www.consumersearch.com/www/software/web-design-software/review.html
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some HTML code into your web page. If your web 
authoring software doesn’t support adding HTML, 
you’ll be out of luck. 
 

 Free Web Page Templates: There are many 
libraries of free web page templates (and tips) to use 
with website building software. For example:  

 www.oswd.org 
 www.openwebdesign.org 
 www.freewebtemplates.com 

 
 Free Web Authoring Software: www.nvu.com 

offers a simple program to create a website. You can 
also find free (and commercial) templates that work 
with Nvu. 
 

 Professional Trade: If you don’t have the 
money, consider bartering (your product or service) 
with a website designer. A web design student may 
be willing to work on your site (for a discount) for 
their portfolio. 
 
 
 
 
 

 Compare the examples (starting on page 70) in 

 -  Website Creation to compare the effort 
and result of different ways to create a website. 

http://www.oswd.org/
http://www.openwebdesign.org/
http://www.freewebtemplates.com/
http://www.nvu.com/
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 Website File Transfer 
 
You’ll eventually need a way to copy files to your 
web host (uploading) as well as copy files from your 
host (downloading). Your website authoring program 
may already have this feature built-in, but if not, 
you’ll need another piece of software, a FTP (File 
Transfer Protocol) client program. 
 

Free FTP Software:  
sourceforge.net/projects/filezilla has a free FTP 
Windows FTP client and cyberduck.ch has a free 
Macintosh OS X FTP client, both well maintained 
and tested. 
 
While each FTP client program is different, they all 
will need: your address (mydomain.com), your user 
name (from your FTP account in your website’s 
control panel), and your user password. 
 
After modifying your website, get into the habit of 
downloading (backing up) your site onto your 
computer (and don’t forget to back up your 
computer as well!).  
 
Delete files on your website with caution. Files that 
may look unnecessary may be vital for running your 
site (the files may be used by your hosting provider, 
for example). 
 

 Example starts on page 68. 

http://sourceforge.net/projects/filezilla
http://cyberduck.ch/
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-  Website Creation 
 
I’ve allocated 11 days to create your website. 
However, if you have a very clear goal (and final text 
and graphics), you may be able to create your site in 
a just few hours. The examples will be invaluable to 
show you how to create common page elements. 
Learning something new takes longer than you 
think it should. As you create your site, you’ll have 
a better appreciation for the web professionals’ who 
craft high-quality websites. 
 
Test your website with different web browsers (e.g., 
Internet Explorer, Firefox, and Netscape). 
Surprisingly, each browser may display your website 
slightly differently. The website 
(www.w3schools.com/browsers/browsers_stats.asp) 
compiles web browser statistics. Currently, Internet 
Explorer 6 is the most popular browser. This means 
that in your website testing, you should at least test 
Internet Explorer 6 (and if you also test Firefox, 
you’ll be testing 80% of the browsers). 
 
Test your website on a slow Internet connection 
(ideally, a dial-up or an older computer). Just 
because things look good and fast on your computer 
doesn’t mean that others will have the same 
experience. People seldom complain about website’s 
problems – they’ll simply go to another website 
(unless they’re very motivated). 
 

 See examples starting on page 70. 

http://www.microsoft.com/windows/ie/default.mspx)
http://www.mozilla.com/en-US/firefox/
http://browser.netscape.com/
http://www.w3schools.com/browsers/browsers_stats.asp
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 Analyze Web Traffic 
 
In a brick-and-mortar store, you can see how many 
people look in you window or come in your front 
door. Online, how do you know if people (“traffic”) 
are visiting your site (other than waiting for the 
phone to ring or for emails)? Knowing how many 
visitors you’re getting will allow you to fine tune 
your marketing efforts. 
 
The process of counting visitors to your website is 
called “website analytics”. I was surprised to find 
out that when I visit a website, information about 
me is passed silently from my browser to the 
website: my IP address, what browser I’m using, the 
website I just visited, etc. The Internet is not the 
anonymous experience many people imagine. 
 

How Create? Analytics? 
Blog Software Yes 
Part of Online Store Maybe 
Web Authoring Software Maybe 

 
 Google Analytics: www.google.com/analytics 

provides lots of website analysis for free. To use it, 
you’ll need a free Google account. 
 
For a fee, some companies offer much more in-depth 
tracking information (e.g., www.clicktracks.com 
currently charges $19+/month). 
 

 See examples starting on page 122. 

http://www.google.com/analytics/
http://www.clicktracks.com/
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 Website Feedback 
 
How do you know if your website is good? Is the 
information on your site useful? The #1 goal of your 
website is to make it easy for people to find out (i.e., 
build trust) about your business. You do want to 
regularly update the website. Just as brick-and-
mortar stores regularly rearrange their products 
(increasing product visibility), you should make 
minor changes to your site (new graphics, new 
offerings, etc.). 
 
Ask people if your website is: 
 

 Easy to read? 
 Easy to navigate? 
 Understandable? 
 Contact information easy to find? 
 Friendly? 
 Quick to load (on their browser)? 
 Missing any information? 

 
You want to consider people’s opinion, but you’re 
also free to ignore their suggestions. 
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 Email Lists 
 
The value of your business is your client list. With a 
client list, you can market to existing clients. With a 
great client list, the value to a potential investor (or 
buyer) of your company is much higher. 
 
Compile a list of email addresses of people who are 
interested in your company. Don’t assume that if 
you’ve emailed someone before (especially socially) 
that they’d be interested in your business. I suggest 
that you email them individually to ask permission 
(opt-in) for you to contact them about your new 
business. If they agree, then add them to your 
company email list. Otherwise, respect their wishes. 
Likewise, as you meet people, get permission to 
email them. Seth Godin’s, Permission Marketing or 
Kim MacPherson’s, Permission Based E-mail 
Marketing both offer more information on building 
your online client list. 
 
For a new business, it might be very tempting to 
grab an existing email list from someone you know, 
or from a list that you find online. Email that you 
send without the receiver’s permission is called 
spam (even if you have an honest intention to help) 
and is unlikely to result in a positive outcome. Your 
email address may be added to a list of spammers 
and your future emails may not go through. At 
worst, you could be fined up to $11,000 per 
incident. Legal details can be found on the Federal 
Trade Commission’s Spam page. 
 

http://www.ftc.gov/bcp/conline/edcams/spam/business.htm
http://www.ftc.gov/bcp/conline/edcams/spam/business.htm
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Design your email “signature”. Most email programs 
allow you to automatically add some preformatted 
text to the end of your email. Your signature should 
contain your name and minimal business contact 
information. You might consider adding a (small) 
logo and/or tag line. 
 

 See example on page 133. 
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 Shopping Carts  
 
To sell products you need to: list products, take 
orders, collect money, and send products. An online 
shopping cart is a way to take orders, collect money, 
and in some cases, send products online and 
automatically. 
 
You need an easy way for people to use your store. 
Think of your local grocery store. Each aisle has a 
list of the kinds of products you can find there. Like 
the grocery store, if you have enough products, find 
common themes (e.g., “holiday gifts”, “for the 
beginner”, “audio”, or “for younger people”). People 
are looking to solve their problem – make it easy to 
identify what problem your products solve. 
 
Some people want the satisfaction of ordering 
products from a person. Some prefer to fax in an 
order. Some don’t trust online shopping carts. Even 
if you create an online shopping cart, make it easy 
to do things the old-fashioned way. Some merchants 
will answer questions over the phone or via email, 
but require people to use the shopping cart instead 
of taking the order directly. 
 
Before you get a shopping cart, you’ll need a bank 
account to collect the money. If you haven’t already 
established a business bank account, do so today (it 
can take up to a week to link your bank to your 
shopping cart).  
 
After linking your shopping cart account to your 
bank account, create a price sheet for the shopping 
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cart to use. You will set up how you want your 
website to work with the shopping cart (should it 
simply handle the money collection or should it also 
take the order?). If your product is downloadable, 
you can even have the shopping cart send the order 
upon receiving the money.  
 

Free Shopping Cart: www.PayPal.com provides a 
simple free shopping cart account. They charge a fee 
to process your order; their fee is comparable to 
other commercial shopping cart choices. 
 

Free eCommerce: If you want to have a 
professional-looking shopping cart, there are a 
number of free options. Such software requires 
computer skills: zencart.com, www.creloaded.com, 
www.oscommerce.com, and www.instinct.co.nz. 
 
A number of companies (resellers) also sell their own 
version of a shopping cart based on 
www.1ShoppingCart.com software (probably the 
most-used shopping cart solution on the Internet). 
 

 See example starting on page 134. 

http://www.paypal.com/
http://zencart.com/
http://www.creloaded.com/
http://www.oscommerce.com/
http://www.instinct.co.nz/
http://www.1shoppingcart.com/
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 One-Page Brochure 
 
Before there were websites, there were brochures. 
Brochures detailed your products (services). They 
were easily read, and easily filed. Now that you have 
a website, do you still need a brochure? Yes. 
 
When talking with someone, you have his or her 
undivided attention. If you tell them about your 
products and give them your card, they would have 
to be motivated to visit your website. Instead, 
handing them a brochure will give them a good 
business introduction. 
 
Make your brochure downloadable from your 
website as a PDF file . This can be invaluable 
when you’re traveling and need a copy in a pinch. 
 
Your brochure should echo the look of your 
business card and your website (this is called 
branding). Eventually, you’d want to have your 
brochure professionally created. Until then create 
one using your favorite word processor.  
 

Word Processor Templates: Many word 
processors (including Microsoft Word™) come with 
built-in templates (including graphics) for creating 
catalogs, menus, and other brochures. Before you 
try to build your own brochure from scratch, look 
through the templates. You can sprinkle graphics 
from your website to your brochure for consistency. 
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 Paper Matters: Use a heavier weight paper 
(24lb.) rather than the common 20lb paper. Heavier 
paper subtly says, “This is important”.  
 

 Easy To Read: Just like your website, the #1 
purpose of the brochure is to make it easy for people 
to find out more about your business. Make sure 
that both your business name and contact 
information are prominently shown (and are 
correct). 
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 What’s Next? 
 
By now, you should have: 
 

 Email correspondence 
 Your functioning website 
 Your shopping cart accepting payment 
 Business cards and flyers 

 
Congratulations, you’ve started your online 
business. However, you work is not done. It’s just 
started. In the next book (“Growing Your Online 
Business”), I’ll cover such topics as: 
 

 Getting the word out 
 Co-marketing 
 Building a product funnel 
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 Step-By-Step Examples 
 
Follow along with Karen as she starts her online 
business (selling soap). These concrete steps will 
help you quickly launch your online business. 
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 Physical Business Example 
 
Karen has decided to sell her handmade soap bars 
online, since her friends love getting them as gifts. 
Her soaps are made from all-organic ingredients, are 
beautiful to look at, and as she knows, make great 
gifts. Her tagline will be “Handmade Organic Soap. 
Cleans Beautifully.” 
 
She decides to name her company simply, “Karen’s 
Organic Soap”. She wanted to use “organic” in the 
name (since that’s a benefit), “soap” (since that’s the 
product), and decided to make is sound boutique-
like (which it is) by adding her name. 
 
She’ll be using a mailbox service (not a post office 
box), so it’ll sound like she has a business address. 
The mailbox service address is located at 123 Main 
Street, San Francisco, California. 
 
Right now, she’s the only one doing the work (and 
she has no investors), so she decides on a sole 
proprietorship.  
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 Name Your Business Example 
 
Karen investigates if her domain name is already 
used (KarensOrganicSoap.com). She enters her 
name into the WHOIS Lookup at www.whois.net, 
and sees the following message: 
 
No match found for 'KarensOrganicSoap.com'. 

 
This is great news, but she also wants to brainstorm 
other possible names for her website (she’s willing to 
change her company name if something better 
comes along). Rather than enter possible names 
one-at-a-time into whois.net, she decides to use 
another free tool: 

domain-suggestions.domaintools.com
 

http://www.whois.net/
http://domain-suggestions.domaintools.com/
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She first searches for “organic soap”, and sees the 
following results: 
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OrganicSoapDirect.com is interesting, but she’s 
concerned that if people forget the “Direct” part of 
the name, they’ll wind up at a competitor’s site 
(OrganicSoap.com), a realistic concern. Next she 
tries, “Karen organic soap”: 
 

 
 
There are a lot of choices here that are interesting. 
She decides to stick with “KarensOrganicSoap.com”, 
but realizes that she might also want to eventually 
purchase some of these secondary domain names 
(“KarenSoap.com”, “KarenOrganic.com”, and 
probably “KarensOrganicSoaps.com”).  
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 Get Your Domain Name And Host 
Example 

 
Karen decides to purchase a 1&1 Beginner Plan 
(Linux Hosting). Clicking on Linux Hosting produces 
a detailed description of the 1&1 Plan. 
 

    
 
 

 
 



50 START YOUR ONLINE BUSINESS IN  DAYS 
 

She confirms her choice. 
 

 
She declines the Symantec Offer (she doesn’t need 
extra protection now). 
  

 
She enters her domain name. 
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She confirms that the name is still available. 1&1 is 
encouraging her to purchase other domain names 
(the same name, but with other suffices), which she 
declines (eventually, she may also purchase these 
secondary domain names, but for now, they’re not 
needed). 

 
 
1&1 confirms the purchase and notes the 12-month 
minimum term. 
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She enters her business information (and is careful 
to select the “Register your domain privately” button 
at the bottom to get a private domain registration). 
She uses her (free) Gmail account as her email (see 
Appendix 1). She omits the apostrophe from her 
company name (since 1&1 has a problem with it). 
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She chooses a password (and writes it down for safe 
keeping). 
 

 
 
She enters her credit card information. 
 

 
 
She authorizes the charge. 
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She gets an order confirmation.  
 

 
 
Within 24 hours she sees in her Gmail account: 
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She logs into https://admin.1and1.com. 
 

 

She clicks on and sees that her domain 
status is “Ready”. This means that the website is 
ready for web pages. 
 

 
 
She confirms that the website is setup by going to: 
KarenOrganicSoap.com and seeing that 1&1 created 
a placeholder web page: 
 

 

https://admin.1and1.com/
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 Find Graphics Example 
 
Since the biggest part of Karen’s business is her 
soaps, she simply decides to take digital pictures of 
her individual soaps. She doesn’t want to take very 
high- resolution pictures, because higher resolution 
means it takes more room to store and time to 
download. 
 
She uses the software that came with her camera to 
crop the photos to show just the soaps and also 
takes a picture of a few bars artistically arranged on 
a sheet of colored paper: 
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 Email Example 
 

Create Your Email Accounts 
 
After she logs into her 1&1 Control Panel, she clicks 

on . Note: The “proxy” email address is where 
1&1 will send administrative emails (including 
invoices). 
 

 
 
She clicks on “New” and chooses “Mailbox”, creating 
the main mailbox Karen@KarensOrganicSoap.com. 
Notice that she enables Virus & Spam protection 
and ensures that this email address is a “Mailbox”. 

 

mailto:Karen@KarensOrganicSoap.com
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1&1 confirms the mailbox was setup. Now, email to 
Karen@KarensOrganicSoap.com will get delivered, 
but to read it, she’ll have to use the 1&1 Mail 
Program (WebMail). Since she wants to have the 
email delivered to her favorite desktop email 
program, she’ll note these addresses for later. 
  
 

 
 

mailto:Karen@KarensOrganicSoap.com
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She sets up a catchall email account (forwarding to 
Karen@KarensOrganicSoap.com).  
 

 
 
She sees her new list of email addresses. 
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Use Web-Based Email Program 
 

Karen clicks on  to inspect her email 
(Karen@KarensOrganicSoap.com). 
 

 
 
Karen uses her password to login. 
 

 
 

mailto:Karen@KarensOrganicSoap.com
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She sees her email account. 

 
 
She tries composing an email from her new email 
account to her Gmail account (and visa versa). She 
clicks on “New E-Mail” and chooses to send a text-
only email (HTML emails contain formatting 
information such as color, bold, etc. – unfortunately, 
not all email programs support HTML). 
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It arrives soon after. 
 

 
 
She tries sending an email to her new email box. 
 

 
 
It arrives soon after. 
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She tries sending an email from her Gmail account 
to help@KarensOrganicSoap.com (to test her 
catchall account) Notice that the “To:” is 
help@KarensOrganicSoap.com (rather than the 
Karen@KarensOrganicSoap.com from her previous 
email). 
 

 

mailto:help@KarensOrganicSoap.com
mailto:help@KarensOrganicSoap.com
mailto:Karen@KarensOrganicSoap.com
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Use Your Own Mail Software 
 
Karen uses Microsoft Outlook™ for emailing. She 
chooses “E-mail Accounts” from her Tools menu and 
sees the following window. She chooses “Add a new 
e-mail account”. 
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She opts for the IMAP protocol. 
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She provides her Internet E-mail settings using 
information when she created the mailbox (or, she 

could look it up using the  button, selecting 
Karen@KarensOrganicSoap.com email address, and 

clicking the  button). 
 

 
 

mailto:Karen@KarensOrganicSoap.com
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The new account is created. All emails that were on 
the 1&1 server have been transferred to her Outlook 
mailbox (and by default were deleted from the 
server).  
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 Business Cards Example 
 
Karen prefers VistaPrint™ for her first set of 
business cards. She had a difficulty with the free 
card layout; her tagline “Handmade Organic Soap. 
Cleans Beautifully” didn’t fit. She removed the word 
organic, since it was repeated in her business name. 
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 Website File Transfer Example 
 
Karen wants to backup her website to her computer. 
She creates a free 1&1 FTP (File Transfer Protocol) 
account clicking on . 

 
 
She clicks the Edit button and notes the password 
(or she could alter it). 

 
 
She downloads, installs, and launches the free 
Windows FTP Client FileZilla (from 
sourceforge.net/projects/filezilla). 
 

 
 

http://sourceforge.net/projects/filezilla
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She enters her address (karensorganicsoap.com), 
account number and password (from her FTP 
account) and notes her successful login. 
 

 
 
She right-clicks on the file “new.html” and selects 
“Download” from the menu. 
 

 
 
She sees new.html has been downloaded to her C: 
drive. She could have also clicked on new.html and 
dragged it to the C: drive (or any folder of her 
choosing). To upload a file, she would drag a file 
from her computer to the appropriate location on 
her website. 
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-  Google Page Creator 
A Free Web Host and Free Web Authoring Solution 

 
 Caution: The biggest downside to using Google 

Page Creator is that the name of the website will be 
yoursite.googlepages.com. If you have no budget to 

create a website, this will suffice. In  Get Your 
Domain Name, I show how to create a more 
professional website (named yoursite.com) for less 
than $40 a year.  
 
After creating her Gmail account (Appendix 1), 
Karen navigates to pages.google.com
 

 
 
She signs in to Google Page Creator. 
 

 
 

http://pages.google.com/
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She sees the Page Manager. 
 

 
 
She creates her new home page by clicking on the 
[no title] window (this will be the default page that 
shows up when you go to yoursite.googlepages.com) 
 

 
 

 Naming: Name your new pages simply. It will 
make identifying between the pages helpful later. 
 
She then creates the following website (in about two 
hours) using her existing digital pictures.  
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The completed website is at: 

KarensOrganicSoap.googlepages.com

http://karensorganicsoap.googlepages.com/
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Summary of Using Google Page Creator 
 
The pros: 

1. Website was created in less than 2 hours. 
2. Manipulating graphics are easy. 
3. Images are optimized for quicker download. 
4. Page layout is simple. 
5. Footer control is good (e.g., can create a 

clickable email address). 
6. HTML code is customizable. 
7. It works. 
8. It’s free. 

 
The cons: 

1. Background graphics can’t be created. 
2. No central template - a change to the layout 

must be done manually on each page. 
3. Limited layouts. 
4. The menu navigation is simplistic. 
5. Hard to rename pages after creation. 
6. Backup of site is hard (can’t use FTP).  
7. Domain name is restricted to 

myname.googlepages.com. 
8. Support is not guaranteed. 
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-  1&1 Website Builder 
Free Web Authoring with your 1&1 Account 

 
Website Builder is free for 1&1-hosted accounts. 
The basic 1&1 account allows you to use Website 
Builder to create an eight-page website. Note: Since 
there is no support for adding HTML code to your 
web pages, you won’t be able to use website 
analytics nor shopping cart software. 
 
Karen logs into her 1&1 account. 
 

 
 
She chooses “Create Website”. 
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She clicks the “Website Builder” button . 

 
 
She starts the Website Settings Wizard. 
 

 
 
Karen chooses a template that connects with 
“nature” (rather than a business theme). 
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The wizard suggests page names based on the 
category of your website. 
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The wizard creates the website. 
 

 
 
She types and pastes in the content. The “what’s 
cooking” text, a link to another page, is created with 

the  tool (selecting the text, clicking on the tool, 
and choosing the “News” page). 
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She changes “Each bar of soap” text to “Heading 3” 
using the text tool bar: 
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Karen converts “Email me” into a clickable email 

address using the  tool (selecting the text, 
clicking on the tool, choosing the “E-mail” tab, and 
entering Karen@KarensOrganicSoap.com). 

 
 

 
 

mailto:Karen@KarensOrganicSoap.com
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She changes the pages’ names with the  control 
(selecting the page to rename and clicking on the 
“Properties”  button). 
 
 

 
 

She reorders the pages with the  control 
(selecting the page to reorder and clicking on the 

 buttons). The Up/Down buttons move the 
page up/down in the list, while the Left/Right 
buttons makes a page not appear at the top level of 
the list of page choices. 
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Using the Settings button, she completes the 
various fields, including the search engine data. 
This data is used to tell the search engines the 
keywords we’d like to be found under. These 
keywords are suggestions (since each search engine 
works differently).  
 

 
 
Karen wants to change the graphics for the top of 

her website using the  button. Here’s one of the 
main places she hits the limitations of templates – 
the graphics have to be exactly the right 
size/orientation or the website won’t look 
consistent. It’s important to find the right template 
with the graphics acceptably close to your vision to 
avoid spending your time trying to struggle through 
the graphic manipulation.  
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 Free Logos: Many websites offer ways to create 
logos (search for “free logo design”). Here are a few: 
 

 cooltext.com generates a simple text logo in 
a number of effects. 

 www.templatesbox.com provides 
Photoshop™ files that you can manipulate 
to create your logo. 

 www.aaa-logo.com provides trial software to 
generate logos on your Windows™ 
computer. 

 
Karen uses cooltext.com to create a simple logo. She 
chooses a style to reinforce her business – soap 
making. 
 

 
 

http://cooltext.com/
http://www.templatesbox.com/
http://www.aaa-logo.com/
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This is her home page after publishing with . 

 
 
 
 
 

 
The completed Website Builder website 

is at: 
KarensOrganicSoap.com

http://karensorganicsoap.com/
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Summary of Using Website Builder 
The pros: 

1. Website was created in less than 2 hours. 
2. Graphics are interesting. 
3. Menu navigation looks good. 
4. It works. 

 
The cons: 

1. Cannot add custom HTML code (for web 
analytics are shopping carts) 

2. There is a lot of wasted white space to the left 
of the logo. 

3. The main (abstract) graphic doesn’t really 
mesh with the grass. 

4. The logo that we chose has the wrong color 
palette. 

5. There is no way to create a clickable email 
address on web page footers. 

6. Tagline isn’t in a great location. 
7. Web pages are poorly named (e.g., 2.html). 
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-  Nvu 
Free Web Authoring Software 

 
Nvu (“N-view”) is free software that works on your 
Macintosh, Windows, and Linux computers. The 
latest version is available at nvu.com. The program 
claims to rival programs like Dreamweaver™. In my 
experience, Nvu is a basic editor missing a lot of 
power of its commercial brethren. However, it’s 
easier to learn to use and the price is great. There 
are both books and websites that have Nvu tutorials 
(e.g., www.yourmachines.org/tutorials/nvu.html). 
 
Karen downloads and installs the latest version of 
Nvu. To create this web page: 
 

 
 

  

http://nvu.com/
http://www.yourmachines.org/tutorials/nvu.html
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She sets the page background color (Format>Page 
Colors and Background). 

 
 
She inserts a 1 x 1 table (using Table>Insert…) 
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She sees on screen: 
 

 
 
She double-clicks the cell, sets the background color 
of the table, and sets the table alignment to center. 
 

 
 
She sees on screen: 
 

 
 
She clicks inside the table, chooses Table>Insert… 
and creates a table that will be inside the 1x1 table. 
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She sees on screen: 

 
 
She double-clicks the table and changes the table 
alignment to center. 

 
She sees on screen: 

 
 
She enters the text into the topmost cell. 

 
 



 DAYS 12-22: NVU 93 
 

  

She selects the first line of her text. She changes the 
text from Body Text  to Heading 1 

. 

 
 

She centers the text using: : 

 
 
She selects the second line of text, centers, and 

italicizes it (using ). She increases the size of 
the text (using ): 
 

 
 
She selects both lines of text. She changes the font 
color from black to white (clicking on the black 

square of  and selecting white): 
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She changes the background color of the cell to blue 
using Format>Table Cell Properties. 
 

 
 
She sees on screen: 
 

 
 
On the last row of the table, she adds her contact 
information. She centers, italicizes, and reduces the 
size of the text. 
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She selects the (non-italicized) Email text and clicks 

on the link button ( ). She enters the email 
address that she wants to associate with the text. 
 

 
 
She sees on screen: 

 
 
In the second row of the table she enters the menu 
of pages in her website. She centers and enlarges 
the text. She changes the background color of the 
cell: 
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One by one, she selects each page name, clicks on 
the link tool, and sets the link location. She knows 
that she’ll have pages named: index.html (the home 
page), store.html, new.html, about.html, and 
contact.html. 
 

 
 
She changes the 3rd row to have a white 
background. 
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Before saving her file, she uses Format>Page Title 
and Properties… to set the title of the page, etc. 
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She saves her “template”. She then continues to 
create all her content using this template (changing 
the name of the file and title as she goes):  
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She publishes each page of her website using the 

 button. 

 
 
 
 

The completed Nvu website is at: 
Nvu.KarensOrganicSoap.com

http://nvu.karensorganicsoap.com/
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Summary of Using NVu 
The pros: 

1. Website was created in less than 2 hours. 
2. Site has the same basic functionality as 

Google Page Creator. 
3. Can add custom HTML code. 
4. It works. 
5. It’s free. 

 
The cons: 

1. No way to create a nice background graphic. 
2. No included Nvu templates. 
3. Menu navigation is simplistic. 
4. Support is not guaranteed. 
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-  WordPress 
Free Blogging Software 

 
WordPress™ is free software for creating your own 
blog. There are actually two ways you can use 
WordPress: create (www.WordPress.com) your own 
free-hosted WordPress blog site (named: 
youname.wordpress.com) or use their software 
(www.WordPress.org) on your hosted website.  
 
Karen decides to install WordPress on her 1&1 

website. She downloads (clicking on ) the 
latest version of WordPress onto her computer (from 
wordpress.org/download). The zip file is actually a 
package of files, so she opens the package 
(wordpress-2.0.5.zip) by double-clicking on it 
(launching the free StuffIt Expander program on her 
computer). Alternatively, by right clicking on the 
package, she could choose another program to open 
the package. A new folder (wordpress) was created 
on her computer containing a number of files and 
folders: 

index.php 
license.txt 
readme.html 
wp-admin 
wp-atom.php 
wp-blog-header.php 
wp-comments-post.php 
wp-commentsrss2.php 
wp-config-sample.php 
wp-content 
… 

http://www.wordpress.com/
http://www.wordpress.org/
http://wordpress.org/download/
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She navigates to her 1&1 Control Panel and clicks 

 to setup a free MySQL account 
(MySQL is a database program that WordPress uses 
to store the website information). She clicks the New 

Database button ( ), carefully noting the 
important information from the setup process: 

 
 
She edits the wp-config-sample.php file from the 
wordpress folder in a text editor and sees: 
 
define('DB_NAME', 'wordpress'); // The name of the   
 database 
define('DB_USER', 'username'); // Your MySQL username 
define('DB_PASSWORD', 'password'); // ...and password 
define('DB_HOST', 'localhost');   // 99% chance you    
 won't need to change this 

 
She inserts from the MySQL Database Setup. 
 

define('DB_NAME', 'db192273801'); // The name of the 
database 
define('DB_USER', 'dbo192273801'); // Your MySQL 
username 
define('DB_PASSWORD', 'FPK4BPBP'); // ...and password 
define('DB_HOST', 'db619.perfora.net');    // 99% 
chance you won't need 
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She saves this file as: wp-config.php (in the same 
folder as wp-config-sample.php). She uploads her 

wordpress folder (  Website File Transfer) to her 
host server. She types into her browser: 

www.KarensOrganicSoap.com/wp-admin/install.php
 

 
 
 

 

http://www.karensorganicsoap.com/wp-admin/install.php
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She logs in. 
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She clicks on “View site”. 
 

 
 
She creates all the pages using the Manage>Pages 
screen (clicking on “Create a new page” for each new 
page). 
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She deletes the default “About” page, and creates 
the following pages. Note: Ensure allow 
comments/pings checkboxes (unchecked), the name 
of the post slug (page name), and the page order are 
correct. 
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She links the “Email me” to her email address 

(selecting the text, clicking on the link button , 
and filling in the link URL). 
 

 
 



110 START YOUR ONLINE BUSINESS IN  DAYS 
 

On her home page she links the “what’s cooking” 
using the link button, filling in the link URL. 
 

 
 
Since WordPress (by default) names pages as 
http://karensorganicsoap.com/?p=123 (not good 
for web browsers), she modifies to “Date and name 
based” using the Options>Permalinks menu (since 
she’s using it to create a website, the “date” isn’t 
used). 
 

 
 
 

http://karensorganicsoap.com/?p=123
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She deletes the default posts in Manage>Posts. 
 

 
 
Her website now looks like: 
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She decides to change the look of her website using 
a new theme. She looks on themes.wordpress.net. 
She narrows down the choices by clicking 1 column 
(she doesn’t want to have a column that shows the 
normal blogging information) and sorts by rating 
(looking for a theme that others have voted for). She 
chooses the “fallseason” theme. She downloads it to 
her computer, unzips the fallseason-10.zip package, 
and uses FTP to upload it to her site’s wp-
content/themes folder. She chooses the theme from 
Presentation>Themes. 
 

 
 

http://themes.wordpress.net/
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Her website now looks like: 
 

 
 
She then spends some time tweaking the theme. 
She modifies a number of the theme’s .php files 
(editing files on her computer, FTPing them to the 
themes/fallseason-10 folder, verifying the changes, 
etc.) Note: The following changes work for this 
theme, but other themes may require different 
changes. 
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She changes the footer.php to have her contact 
information. The &#8226 is a HTML code (from 
www.ascii.cl/htmlcodes.htm) for the bullet (•) 
character. Text between the <i> and </i> is 
italicized. The <a href> is how HTML makes text 
linked to an action. In this case, clicking on Email 
will “do the right thing”. 
 
</div> 
<div id="footer"> 
   <div align="center"><i>Karen The Soapmaker 
&#8226; 123 Main Street &#8226; San Francisco, CA 94123 
&#8226; (415) 555-1212</i> <a 
href="mailto:Karen@KarensOrganicSoap.com">Email</a></div> 
   <?php wp_footer(); ?> 
 </div> 
 
</body> 
</html> 

 
 

http://www.ascii.cl/htmlcodes.htm
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She edits page.php to modify the web page display 
(eliminating the comments area and the blogging 
information on the right side). 
 
<?php get_header(); ?>  
 <div id="normalcontent">   
  <!-- Primary content: Stuff that goes in the 
primary content column (by default, the left column) --> 
    <div id="contentarea"><!-- Primary content 
area start --> 
    <?php if ($posts) { 
     foreach($posts as $post) 
     { 
      start_wp(); 
     ?> 
     <div class="post" id="post-<?php 
the_ID(); ?>"> 
      <h4><a href="<?php the_permalink() 
?>" rel="bookmark" title="Permanent Link to <?php 
the_title(); ?>"><?php the_title(); ?></a></h4> 
      <div class="contentarea">  
       <?php the_content('Continue 
Reading &raquo;'); ?> 
      </div> 
     </div>   
     <?php comments_template();?>   
     <?php 
     } /* end for "for-each" */ 
    }/* end for "if posts" */ 
    else 
    { 
     echo '<p>Sorry, No Posts matched your 
criteria.</p>'; 
    } 
    ?> 
    <p align="center"><?php posts_nav_link(' - 
','&#171; Prev','Next &#187;') ?></p> 
 </div><!--content end --> 
<?php get_footer();?> 
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She changes the header.php to display the web 
pages in page order (by default it displays the pages 
in alphabetical order) and to remove the default 
Home page (which is a blog page): 
 
 … 
 <div id="menu"> 
  <ul> 
   <?php wp_list_pages(' 
sort_column=menu_order&title_li=&depth=1&'.$page_sort.'&'
.$pages_to_exclude)?> 
  </ul> 
 </div> 
 <div id="menubottom"></div> 
 
She also removes the search box from the site by 
deleting the following text from header.php. 
 
<div id="search"> 
 
  <form id="searchform" method="get" action="<?php 
bloginfo('siteurl')?>/index.php"> 
 
   <label for="s" id="lblSearch"><?php _e('Find'); 
?></label><br/> 
 
   <input type="text" name="s" id="s" class="text" 
value="<?php echo wp_specialchars($s, 1); ?>" size="15" 
/> 
 
   <input type="submit" id="searchsubmit" 
value="Go" class="submit" name="searchsubmit"/> 
 
  </form> 
 
</div> 

  
Since she doesn’t want to display a sidebar (the 
blogging info), she deletes the contents of 
sidebar.php (but not the file itself). 
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Although she likes the images of the fall leaves, it 
doesn’t match her site’s content. She decides to use 
her digital picture. She uploads it to snipshot.com, 
downloads a cropped image of 140 pixels tall, and 
names the file “soap.jpg”. The file is uploaded to the 
images folder in fallseason-10.  She changes the 
relevant part of style.css. 
 
… 
#headerpic 
{ 
position: relative; 
height: 140px; 
background: #fff url(images/soap.jpg) repeat-x bottom 
left; 
margin-bottom: 2px; 
} 
… 
 
Finally, she creates the file “home.php” (with the 
following contents) and uploads it to her fallseason-
10 theme folder. 
 
<?php 
$homepage = get_settings('siteurl')."/home/"; 
wp_redirect($homepage); 
exit(); 
?> 
 
This file causes her “home” page (the page’s post 
slug must be named “home”) to be shown when 
someone goes to her site.  
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Here’s the result of her work: 
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Summary of Using WordPress 
The pros: 

1. Website was created in less than 10 hours. 
2. Large number of nice-looking (free) templates. 
3. Can add custom HTML code. 
4. It works. 
5. It’s free. 

 
The cons: 

1. Computer savvy is needed to install and 
customize. 

2. Support is not guaranteed. There is a large 
group of devoted users that have an active 
discussion area where you may be able to get 
help for your problem. 

 
 

 
The completed WordPress website is at: 

WordPress.KarensOrganicSoap.com

http://wordpress.karensorganicsoap.com/


122 START YOUR ONLINE BUSINESS IN  DAYS 
 

 Google Analytics 
Creation of Google Analytics Account 

 
Using her Gmail account, Karen creates her Google 
Analytics account (www.google.com/analytics). 
 

 
 

 
She types the URL (domain name) of her website. 

http://www.google.com/analytics/
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She enters her account information: 
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She gets new HTML code to add to her website. 

 
 
She looks at her settings (“control panel”).  

 
 
How the HTML code is used differs depending on 
her web authoring choice (see following pages). 
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 Google Analytics with Google Page 
Creator 

 
After creating her Google Analytics account (with 
KarensOrganicSoap.googlepages.com), she sees the 
following code: 
 

<script src="http://www.google-
analytics.com/urchin.js" type="text/javascript"> 
</script> 
<script type="text/javascript"> 
_uacct = "UA-1150735-1"; 
urchinTracker(); 
</script> 

 
She logs in to her Page Creator account, clicks on 
her web pages one-by-one. On each page, she 
selects the content (middle of the page), clicks the 

 button (in the bottom right of the page) 
and pastes the above code at the end. 
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She publishes each page. She returns to her Google 
Analytics account to confirm the tracking code was 
installed correctly (clicking ). 
 

 
 
 
She clicks  button to see her statistics 
(nothing to show…yet). 
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 Google Analytics with 1&1 Website 
Builder 

 
Website Builder doesn’t support adding HTML code 
to her site. Therefore, Karen cannot use metrics. 
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 Google Analytics with Nvu 
 
After creating her Google Analytics account (and 
specifying her URL as nvu.KarensOrganicSoap.com), 
she sees the following code: 
 

<script src="http://www.google-
analytics.com/urchin.js" type="text/javascript"> 
</script> 
<script type="text/javascript"> 
_uacct = "UA-1150735-2"; 
urchinTracker(); 
</script> 

 

She launches Nvu, opening her web pages one-by-
one. On each page, she clicks on the  
button, scrolling down to the end of her HTML page 
source: 
 
 … 

<br> 
</body> 
</html> 

 

Just before the </body> she pastes the above code: 
 
 … 

<br> 
<script src="http://www.google-
analytics.com/urchin.js" type="text/javascript"> 
</script> 
<script type="text/javascript"> 
_uacct = "UA-1150735-2"; 
urchinTracker(); 
</script> 
</body> 
</html> 

 

She publishes each page, being careful to make sure 
that the check box “Include images and other files” 
is not checked (this is a technical problem): 
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She returns to her Google Analytics account to 
confirm the tracking code was installed correctly by 
clicking . 
 

 
 
She clicks  button to see her statistics 
(nothing to show…yet). 
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 Google Analytics with WordPress 
 
After creating her Google Analytics account (with 
wordpress.KarensOrganicSoap.com), she sees the 
following code: 
 

<script src="http://www.google-
analytics.com/urchin.js" type="text/javascript"> 
</script> 
<script type="text/javascript"> 
_uacct = "UA-1150735-3"; 
urchinTracker(); 
</script> 

 
She downloads the free Google Analytics Plugin 
www.semiologic.com/software/google-analytics. She 
follows the directions, unzipping the “sem-google-
analytics.zip” package and uploading it to the wp-
content/plugins folder. She logs into her site (wp-

admin.php), and clicks the  button. 
 

 
 

http://www.semiologic.com/software/google-analytics/
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She activates the plugin (using the button). 

She clicks the  button and then clicks the 

 button. She pastes in the Google 
Analytics code into the window. 
 

 
 
She returns to her Google Analytics account to 
confirm that the tracking code was installed 
correctly (clicking ). 
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She clicks on  button to see her statistics 
(nothing to show…yet). 
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 Email Lists 
 
Karen decides to echo her website’s tag line in her 
signature. She adds enough contact information to 
make it easy for customers to contact her. 
 

Karen The Soap Maker 
KarensOrganicSoaps.com 
Handmade Organic Soap. Cleans Beautifully. 
(415) 555-1212 
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 PayPal  
 
Karen selects PayPal to take orders. She can later 
switch to a fancier shopping cart should the need 
arise.  
 
Note: Adding Shopping Cart Support to a website is 
quite similar to adding website analytics. In both 
cases you need to add HTML to your web pages. 
This means that 1&1 Website Builder could not be 
used with PayPal. 
 
She goes to www.PayPal.com and requests a new 
business account. 

 

 
 

http://www.paypal.com/
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She creates the account. 
 

 
 
She provides information about her business. 
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She enters her business contact information. 
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She provides her business account information. 
 

 
 
She confirms her email address: 
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The email from PayPal was placed in her “Spam” 
folder. 
 

 
 
She opens the “Activate Your PayPal Account” email. 
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She clicks on “Click here to activate your account”. 
 

 
 
Her email address is confirmed. 
 

 
A few days later, she contacts her bank. PayPal had 
made two small deposits into her account to verify 
that the account is valid. She confirms her bank 
account. 
  

 
 
She enters the two deposits. 
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Her account is confirmed.  
 

 
 
She finds a payment solution.  
 

 
 
Karen doesn’t have a merchant account and simply 
wants to process orders via PayPal on her website. 
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Based on her choices, PayPal recommends the 
Website Payments Standard. 
 

 
 
She implements the solution.  

 
 
She reads the overview and watches the demo. She 
wants her customers to click the payment button 
and complete the order form on PayPal.  
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She clicks on “Learn how to use Website Payments 
Standard” and reads the technical overview.  
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She clicks “PayPal Shopping Cart – Integrate now.”  
 

 
 
She clicks “PayPal Shopping Cart” 
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She creates her first catalog item. 
 

 
 
She clicks  
 

 
 
She adds the button to her website. The process 
differs depending on her web page authoring 
program (see following pages). 
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 PayPal  Google Page Creator  
 
Karen adds the HTML code for each PayPal button 
by first clicking on the  button. She finds 
where in the web page she wants to add the button. 
 

 
 
After the “not abrasive.<br></p>” she pastes in the 
PayPal HTML code.  
 

 
 
She clicks on the  button. 
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She clicks the  button. She checks her 
site and sees: 
 

 
 
 
She clicks on  to test the site. 
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 PayPal  1&1 Website Builder  
 
Because she cannot add HTML code to her 1&1 
Website Builder template, Karen cannot use PayPal 
buttons. 
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 PayPal  Nvu 
 
Karen adds the HTML code for the PayPal button by 
clicking the  button. She finds where in the 
web page she wants to add the button. 
 

 
 
After the “not abrasive.<br>” she pastes in the 
PayPal HTML code.  
 

 
 

She clicks on the  button. 
 

 
 



 DAY 26: PAYPAL+NVU 149 
 

  

She saves and publishes her web page. She checks 
the live site and sees: 
 

 
 

She clicks on  to test the site. 
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 PayPal  Wordpress  
 
Go Slowly: Adding a PayPal button to Wordpress is 
quite detailed. 
 
Starting with the PayPal HTML button code: 
 

<form target="paypal" 
action="https://www.paypal.com/cgi-bin/webscr" 
method="post"> 
<input type="image" 
src="https://www.paypal.com/en_US/i/btn/x-click-
but22.gif" border="0" name="submit" alt="Make 
payments with PayPal - it's fast, free and 
secure!"> 
<img alt="" border="0" 
src="https://www.paypal.com/en_US/i/scr/pixel.gif" 
width="1" height="1"> 
<input type="hidden" name="add" value="1"> 
<input type="hidden" name="cmd" value="_cart"> 
<input type="hidden" name="business" 
value="paypal@KarensOrganicSoap.com"> 
<input type="hidden" name="item_name" 
value="Freesia"> 
<input type="hidden" name="amount" value="5.00"> 
<input type="hidden" name="no_shipping" value="2"> 
<input type="hidden" name="no_note" value="1"> 
<input type="hidden" name="currency_code" 
value="USD"> 
<input type="hidden" name="lc" value="US"> 
<input type="hidden" name="bn" value="PP-
ShopCartBF"> 
</form> 
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Karen converts the PayPal button text into a format 
that WordPress can use in her favorite text editor. 
She changes each of the input type lines. 
 

<form target="paypal" 
action="https://www.paypal.com/cgi-bin/webscr" 
method="post"> 
<input type="image" 
src="https://www.paypal.com/en_US/i/btn/x-click-
but22.gif" border="0" name="submit" alt="Make 
payments with PayPal - it's fast, free and 
secure!"> 
<img alt="" border="0" 
src="https://www.paypal.com/en_US/i/scr/pixel.gif" 
width="1" height="1"> 
add=1&amp; 
cmd=_cart&amp; 
business=paypal@KarensOrganicSoap.com&amp; 
item_name=Freesia&amp; 
amount=5&amp; 
no_shipping=2&amp; 
no_note=1&amp; 
currency_code=USD&amp; 
lc=US&amp; 
bn=PP-ShopCartBF&amp; 
</form> 
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She replaces the <form> and </form> text. 
 

<a href="https://www.paypal.com/cgi-bin/webscr? 
<input type="image" 
src="https://www.paypal.com/en_US/i/btn/x-click-
but22.gif" border="0" name="submit" alt="Make 
payments with PayPal - it's fast, free and 
secure!"> 
<img alt="" border="0" 
src="https://www.paypal.com/en_US/i/scr/pixel.gif" 
width="1" height="1"> 
add=1&amp; 
cmd=_cart&amp; 
business=paypal@KarensOrganicSoap.com&amp; 
item_name=Freesia&amp; 
amount=5&amp; 
no_shipping=2&amp; 
no_note=1&amp; 
currency_code=USD&amp; 
lc=US&amp; 
bn=PP-ShopCartBF&amp; 
</a> 
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She replaces the <input type = “image”> text. 
 

<a href="https://www.paypal.com/cgi-bin/webscr? 
add=1&amp; 
cmd=_cart&amp; 
business=paypal@KarensOrganicSoap.com&amp; 
item_name=Freesia&amp; 
amount=5&amp; 
no_shipping=2&amp; 
no_note=1&amp; 
currency_code=USD&amp; 
lc=US&amp; 
bn=PP-ShopCartBF&amp; 
<img width="86" height="23" class="center" 
title="Add To Cart" alt="Add To Cart" 
src="http://images.paypal.com/en_US/i/btn/x-click-
but22.gif" /> 
</a> 
 

She replaces the “@” with %40, the “.” with %2e, 
and the “-” with %2d 
 

<a href="https://www.paypal.com/cgi-bin/webscr? 
add=1&amp; 
cmd=_cart&amp; 
business=paypal%40KarensOrganicSoap%2ecom&amp; 
item_name=Freesia&amp; 
amount=5&amp; 
no_shipping=2&amp; 
no_note=1&amp; 
currency_code=USD&amp; 
lc=US&amp; 
bn=PP%2dShopCartBF&amp; 
<img width="86" height="23" class="center" 
title="Add To Cart" alt="Add To Cart" 
src="http://images.paypal.com/en_US/i/btn/x-click-
but22.gif" /> 
</a> 
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She joins the separate lines into a single line. 
 

<a href="https://www.paypal.com/cgi-
bin/webscr?add=1&amp; 
cmd=_cart&amp;business=paypal%40KarensOrganicSoap%
2ecom&amp;item_name=Freesia&amp;amount=5&amp;no_sh
ipping=2&amp;no_note=1&amp;currency_code=USD&amp;l
c=US&amp;bn=PP%2dShopCartBF&amp; <img width="86" 
height="23" class="center" title="Add To Cart" 
alt="Add To Cart" 
src="http://images.paypal.com/en_US/i/btn/x-click-
but22.gif" /></a> 
 
 

Karen adds this new HTML code for the PayPal 
button by first clicking on the  button. She 
finds where in the web page she wants to add the 
button.  
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She clicks the  button. 
 

 
She clicks on the  button. She checks the live 
site. 
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She clicks on  to test the site. 
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Appendix 1: Free Gmail Account 
 
If you don’t already have an email account, you may 
want to create a free Gmail (Google email) account.   
 
1. Since Gmail accounts are currently by invitation-
only, get your invitation from www.bytetest.com. 
Visit the site and enter the code to get the free 
account:  

 

 
 
2. Register your Gmail account:  

 

 
 

You can now receive email at name@gmail.com

http://www.bytetest.com/
mailto:name@gmail.com
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Credits 
 
While the idea for this book is mine, I depended 
upon a number of sources, including: 
 

 For icons ( , , and ): 
http://www.famfamfam.com/lab/icons/silk/ 

 For WordPress: http://wordpress.org/support/ 
 For General Info: Google and Google Images 
 For Nvu: http://www.nvu.com/index.php 

 
 
 
 
 
 

If you have any corrections, 
suggestions, or questions please 

contact me: lyob@ManyGoodIdeas.com. 
 

http://www.famfamfam.com/lab/icons/silk/
http://wordpress.org/support/
http://www.nvu.com/index.php
mailto:lyob@ManyGoodIdeas.com


 
Glossary 

 
Blog.  (“web log”) Online articles, like a diary,  
managed by software that also easily edit web 
pages. 
 
Domain Name. Unique name for a computer on a 
network (mywebsite.com). The prefix for a domain 
name is called a hostname (or subdomain), e.g., 
help.mywebsite.com) 
 
 
Email. (“Electronic mail”) An Internet postal system 
that sends and receives messages. Email addressed 
to one email address can be forwarded to another 
email address (just like US Mail). Email addresses 
generally have the format: name@domain (e.g., 
mary@mywebsite.com) 
 
Gmail. Google’s free email program. 
 
Home Page. The (default) page shown when 
navigating to a domain address. The home page is 
usually named index.htm or index.html.  
 
Hosting. The service of storing a website and 
allowing others to view pages of it. 
 
HTML. (“Hypertext Markup Language”) A computer 
language that describe to a web browser how, what, 
and where to display information on screen. 
 
Internet Provider. A company whose service allows 
connection to the Internet (either by dial-up, DSL, 
cable modem, satellite, etc.). 

http://www.mywebsite.com/
mailto:name@domain
mailto:mary@mywebsite.com


 

  

PDF.  (“Portable Document Format”) A file 
format permitting people (using different types of 
computers) to see the same images and text. 
 
Provider. See Internet Provider. 
 
Search Engine. A service that finds websites that 
match your entered keywords (e.g., Google or Yahoo) 
 
Shopping Cart. A way of displaying goods/services 
online for purchase 
 
Spam. Unwanted email. 
 
URL. (“Uniform Resource Locator”) A name 
(generally starting with http), containing a domain 
name and any optional subdirectories (e.g., 
http://www.mywebsite.com/store) 
 
Web Host. See Host. 
 
Web Page. A HTML file (usually ending in .htm or 
.html) 
 
Website. A collection of (related) web pages for a 
domain. 
 
Web Server. A computer program that sends 
(HTML) web pages to a user’s browser. 

http://www.mywebsite.com/store


 

Start Your Online Business in  Days 
Without a Lot of Money: 

An Easy Step-By-Step Guide 
 
 

Do you need more help with your online business?  
 

 Other Books 
 Speaking/Seminars 
 Consulting 
 CDs 
 DVDs 

 
Contact me: 
 

Jay Hamilton-Roth 
c/o MGI Publishing 
16 Juanita Avenue 
Mill Valley, CA 94941-2109 
www.ManyGoodIdeas.com
 
(415) 389-8920 
lyob@ManyGoodIdeas.com
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